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2 Productivity Pack 8 Hotfixes 1-6

Overview of Hotfixes 1-6

This hotfix release is a cumulative software update that includes all the software changes in the Productivity
Pack 8 hotfixes 1-6. These software change are described in the sections “Using the New Enhancements”
on page 4 and "Hotfix Software Changes and Fixes"” on page 5.

Important Notes

e Beginning with Dentrix G4, Henry Schein Practice Solutions no longer develops solutions for or tests
compatibility with Windows 2000. Dentrix G4 will not install on Windows 2000 or prior Windows
operating systems.

e Visit www.dentrix.com/products/dentrix for a current copy of the Dentrix G4 system requirements.

e Henry Schein Practice Solutions recommends that you install this update at a time that is outside your
regular office hours.

e Forinformation about using the new features in Productivity Pack 8, refer to “Using the New Features
and Enhancements” in this document or refer to the Dentrix Help. For information about new
features and enhancements in previous Dentrix releases, see the “What's New in Dentrix?"” section of
the Dentrix Help.

Installing Dentrix G4 Productivity Pack 8
Hotfixes 1-6

The Dentrix G4 Productivity Pack 8 Hotfixes must be installed on each workstation that runs Dentrix. You
can easily install the hotfixes using the Check for Updates feature.

Complete the following steps to check for updates and install the hotfixes. If the update notification
appears automatically, skip to Step 3.

1. Before installing the hotfixes, you must have installed Productivity Pack 8.
2. Right-click the Dentrix Quick Launch icon in the notification area of the Windows task bar to open the

Quick Launch menu. Next lic Updates and
then click Check for Updates.

Dentrix has found 1 updates

The Check for Updates progress message ./ would you like to download these updates now?
appears, fO”OWed by the DOWI’]|Oadab|e Ta learn more about the updates that are available click HERE.
Updates dialog box. Recpired Updales:

+ DEMTRIX G4 Producsivity Pack 8 Hotfis 5 11.3 MB

If the Dentrix Quick Launch icon is not
displayed in the notification area, you can
check for updates by clicking About Dentrix
from the Help menu of any module and then
clicking the Check for Updates link.

NOTE: Any Required Updates that are downloaded will be installed immediately. |t is
recommended that you wait to download updates during a time that you will not be:

About DENTRIY X actively using Dentrix.
" fems marked reguire a8 restaif of fre Downloadable Yodale program: This will
Serial Mumkber: Hfappen sufomaticall, buf il raguie pou fo reselect ire opfional updafes fsfed
] DENTRIX G4 11111111111
= Copyright 1987-2011 Optional Updates:
g T Heniy Schein, Inc.

|DENTRIX| Al Rights Reserved.
Installed Products:
Product Wersion »~
Appointment Book 1422280 G iy Wi
Appointment Ligt 1422280 Provide Feedback
Dentrix Print 1422280 B
Document Center 14.2.228.0
Diiweb 14222680 2hetemlnfoS | .
Family File 1422780 Mota: Downloading updatas may iake saveral minulas.
Led 14.2.228.0 v Close I
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Note: If there is a problem with your Internet connection, an error message may appear. Check your
Internet connection and try to check for updates again.

3. Click Yes to download the Required Updates.
The Download Progress message appears while the updates are downloaded and installed.

If you do not have sufficient time to install the update, click the Install Later button and install the
hotfixes when you have several minutes to an hour or more to dedicate to installing the hotfixes on
the server and on each computer in the office.

4. Follow the on-screen instructions to install the hotfixes.

For help with the download and installation of Dentrix G4 Productivity Pack 8 hotfixes, contact Dentrix
Support at (800) 336-8749.

Installing the Hotfixes on Other Computers

The hotfixes must be installed on each workstation that runs Dentrix G4. Once the hotfixes are installed
on one computer on your network, you can easily install them on any other computer on your network
when you launch any Dentrix module.

When you attempt to open a module on a computer that does not have the required updates, a message
appears notifying you that updates need to be installed.

Important: You must install the required updates in order to use Dentrix on that computer because every
computer on your network must run the same version of Dentrix.

To install the updates, click Install Now from the message that appears. All open Dentrix programs
should close and an install status message box appears. The updates will install and you can then access
Dentrix on that computer.

Dentrix G4 Productivity Pack 8 Release Guide




4 Productivity Pack 8 Hotfixes 1-6

Using the New Enhancements

The following information will help you understand how to use the enhancements in this hotfix release.

Office Manager

NEW PRESCRIPTION FORMS HAVE BEEN ADDED FOR CALIFORNIA, GEORGIA, AND KENTUCKY

Two new California prescription forms and a new Kentucky prescription form have been added to the
Printer Setup Form list to support printing on tamper-resistant security paper. The Standard form has also
been modified so the offsets can be adjusted; this change makes it possible to print on Georgia
prescription forms.

To select a new form

1. In the Office Manager, from the Maintenance menu, point to Practice Setup, and then click
Prescriptions Setup.

Click Print Setup.

Under Form, select one of the following forms:
o CA Half Sheet

e CAFull Sheet

e KY Standard

A NEW CLAIM FORMAT HAS BEEN ADDED FOR IDAHO

ldaho Medicaid requires all claims, regardless of relation to subscriber, to print the assigned patient chart
number in box 23. The standard DX2007 claim format (and variants) left box 23 empty if the “Relationship
to Subscriber” was set to “Self.” A new claim format has been added. After installing the update, you will
need to add the new claim format to Definitions as IDMED2K?7.

To add the new claim format

1. In Office Manager, from the Maintenance menu, point to Practice Setup, and then click Definitions.
2. Under Definition Type, select Claim Format.

3. Ifthe Claim Format is to be used for all Patients or Plans, select the main claim format that you use.
(This is usually in the #1 position.).

If the Claim Format applies to only a few specific insurance plans, select a format that is not currently
being used by any other insurance plan.

Under Definition Text, clear the current information in the two fields (including any spaces).
5. Inthe first box, type a short name for the new Claim Form, such as IDMEDO7.

In the second, longer field, type the abbreviation for the new Dentrix claim format: IDMED2K?7. (This
field is case sensitive.)

7. Click Change.

This changes the claim format being used by any plan that was attached to this claim form.

Dentrix G4 Productivity Pack 8 Release Guide
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Hotfix Software Changes and Fixes

The Dentrix G4 Productivity Pack 8 hotfixes contains the following software changes and fixes:

Appointment Book

e An error message, “Cannot read appointment file (118)" occurred randomly while switching days in
the Appointment Book. This has been fixed.

Famlly File

If a patient questionnaire form required a response for “Pl-Patient Demographics, Brief,” it would not
update the patient information. The message, "There isn't any information to update” would appear.
This has been fixed.

e On the NY State Form Full Sheet, the NPl number (from the Practice Resource Setup) was printing
too far to the right (over the crop mark) and was cut off at the 7th number when ripped from the
perforation lines. The prescriber name also printed too far to the right and would not all fit if there
were more than 30 characters in the prescriber name. These issues have been fixed.

Miscellaneous

* When a payment table included an amount of $0 for a procedure that the deductible would normally
apply to, Dentrix did not apply the deductible to the next procedure that should have a deductible.
This has been fixed.

Offlce Manager

After installing Dentrix G4 Productivity Pack 6, the Provider Aging Report included only one patient.
This has been fixed, and all patients that should appear on this report now appear. On the Daily
Huddle Report, the Completed Prior Day column showed the same amounts no matter what date the
report was run for. This has been fixed.

e On the Daily Huddle Report, the Past Due amount for patients who had a family payment agreement
past due did not match the amount in the Ledger. This has been fixed, and the amounts are now the
same.

e On the Daily Huddle Report, patients who had a continuing care due date in the future appeared
incorrectly on the Overdue Continuing Care section of the Scheduled Patients Summary. This has
been fixed.

e After performing an eligibility update, the Daily Huddle Report did not provide the correct patient
eligibility status.

e On the Daily Huddle Report, if only one member of the family had a future appointment, the family
was incorrectly reported as “Family w/o Appt” in the Scheduled Patients Summary section. This has
been fixed.

e The Patient Visit Form placed the comma and decimal in an incorrect location in the Account Guar
box for the Balance, Estimate, and so forth. This has been fixed.
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Questionnaires

e When filling out a questionnaire form that included date fields, such as the birth date field in the
Patient Information Form, the form would accept dates without slashes /' (such as 05251970) but
would not reformat them using slashes so they could be copied into the Family File. This has been
fixed.

*  When opening the Questionnaires module from another Dentrix module where a patient was
selected, the Questionnaires module would sometimes open but not display the selected patient.
This would only happen with certain patients in the database. This has been fixed.

e |f there were differences between the employer information on the questionnaire and the patient’s
Family File information, using Update Patient Information would leave the Pl - Employer Info section
red in the Update Patient Information window. This has been fixed.

e The Questionnaires module did not automatically update the questionnaire response date when
patients entered new responses, making the questionnaire appear as if the responses had not been
saved. This has been fixed.

e Editing a Yes/No question in a questionnaire would automatically change a default answer of No to
Yes. This has been fixed. When moving a signed patient questionnaire response, Dentrix would
remove the signature. This has been fixed.

¢ When a patient questionnaire used condensed text and had extra blank lines between the different
sections, the blank lines were removed on the second page. This has been fixed.

e On afew questionnaire forms with certain formatting, some check box responses did not appear in
the correct location and were pushed off the screen. In some instances it also caused the text and
graphic images to be condensed and distorted. This has been fixed.

e When entering new responses in a questionnaire, if you entered a work phone extension and tried to
update the information to the Family File using Update Patient Information, the extension was left
blank and highlighted in red. Clicking Update Family File would return a message saying there was
nothing to update. This has been fixed.

e When attempting to create a new employer in a questionnaire using the Create New button, Dentrix
would return the error: “Please use the Employer Options button to select a valid Employer.” This has
been fixed.

® When using the Questionnaires module to add a new family member from the “Spouse/Resp Party”
section, Dentrix did not add the new family member. This has been fixed.

e When entering new responses in the Questionnaires module for a form with Primary Insurance
Information, the insured’s birth date was not automatically filled in with the subscriber’s birth date
information from the Dentrix database. This has been fixed.

How to Learn More about this Release

For information about new features and enhancements in previous Dentrix releases, see the "What's New
in Dentrix?"” section of the Dentrix G4 Help.

You can view on-demand tutorials, sign up for live webinars, and view webinars in the Resource Center at
dentrix.com if you have an active customer service plan. From the Resource Center, you can also access
PDF copies of the Reports Reference, User's Guide, System Requirements, and FAQs.
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2 Productivity Pack 8

Overview and New Features

This Dentrix G4 Productivity Pack 8 Release Guide provides information about the new Productivity Pack
8 software release. This overview section includes important notes regarding this release, followed by a
brief description of the new features and enhancements available in this release.

Note: For information about using the new features in this Productivity Pack, refer to “Using the New
Features and Enhancements” in this document or refer to the Dentrix Help. For information about new
features and enhancements in previous Dentrix releases, see the “What's New in Dentrix?” section of the
Dentrix Help.

Important Notes

e Beginning with Dentrix G4, Henry Schein Practice Solutions no longer develops solutions for or tests
compatibility with Windows 2000. Dentrix G4 will not install on Windows 2000 or prior Windows
operating systems.

e Visit www.dentrix.com/products/dentrix to download an updated copy of the Dentrix G4 system
requirements.

e Henry Schein Practice Solutions recommends that you install this update at a time that is outside your
regular office hours.

New Features

Dentrix G4 Productivity Pack 8 includes the following new features and enhancements:

APPOINTMENT BOOK

® You now have one-button access through the Appointment Book, Chart, and Treatment Planner
toolbars to Digital Dental Exchange (DDX). Through DDX you and your staff can order and track lab
work with less disruption to patient visits.

® The Attach Case button in the Appointment Information dialog box was renamed Patient Lab Cases.
The Patient Lab Cases dialog box now includes the New DDX Rx and DDX Case List buttons.

e From the Pinboard, you can now restore all scheduled appointments or events to the Appointment
Book by right-clicking an appointment or event and selecting Restore All Pinboard Appointments/
Events from the menu.

e From the Schedule Event and Edit Event dialog boxes, you can now click the Pinboard button to
place the event on the Pinboard.

e From the Edit Event dialog box or the Appointment Book toolbar, you can delete an event by clicking
a new Delete button.

® The new Patient Visit Form is a customizable route slip that you can view or print for a selected
appointment, a certain patient, or multiple patients by clicking the Patient Visit Form button on the
Appointment Book toolbar. (You can also generate this form for one or more patients from the Office
Manager.)

LEDGER

e From the File menu in the Ledger, you can select Insurance Payment Setup to set up default
insurance write-off and refund adjustment types, enable automatic adjustments for insurance
payments, and post refund adjustments automatically. Additionally, you can set up secondary
insurance claims to be created automatically whenever primary claim payments are made.

e The Check # fields in all areas of Dentrix in which a payment can be entered or displayed now allow
up to 20 characters. Previously, these fields only accepted up to nine characters.

Dentrix G4 Productivity Pack 8 Release Guide
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OFFICE MANAGER

® Three new prescription forms have been added to the Printer Form Setup List to support printing on
tamper-proof paper.

PRESCRIPTIONS

* You can now correct prescription dates, if necessary, or enter a date for a new prescription that cannot
be filled immediately. This can be very convenient for patients who cannot return for an office visit or
when a doctor is not available to patients.

®  You can find, review, and refill prescriptions by clicking the new Refill button.

QUESTIONNAIRES

* You can now require answers to questionnaire questions, ensuring that patients provide information
critical to your practice, such as secondary insurance policies.

®  The Submit button is now disabled until all required questions are answered and until the last page of
a questionnaire.

* You can now set an expiration period for responses to questionnaires and prompt your staff when
patients must re-confirm their information. Letting Dentrix track patient information frees your staff to
spend more time on more critical duties.

e When you select a referral, employer, or insurance plan from the Update Patient Information dialog
box in the Questionnaires module, the corresponding text that was entered in the Questionnaire
form automatically populates the name fields of the Select Patient, Select Employer, and Select
Dental Insurance windows respectively.

e With the Questionnaire Response to Note Field option, you can import patient comments from a
questionnaire to create a patient, guarantor account, or clinical note. You can also use a patient
comment to create a patient or family alert.

e When you add, change, or delete medical alerts in Definitions, you can automatically update any
Questionnaire forms that use medical alerts.

MISCELLANEOUS

e Installing the Dentrix G4 Productivity Pack 8 automatically installs a plug-in for Microsoft Word 2007
and 2010. With this plug-in, you can easily view and insert data merge field codes to create custom
Microsoft Word mail-merge templates.

e The new Dentrix Launcher lets you open the Dentrix modules from a graphical virtual front office and
operatory. This virtual practice lets new users learn the domain of each module intuitively. With this
understanding, they can quickly learn to navigate the system and complete routine tasks.

PRACTICE ADVISOR

® The new Daily Huddle Report includes a collection of reports that gives practices a view of the daily
schedule and key performance metrics. Office managers can measure performance against monthly
goals for production, scheduling, collections, and attracting new patients. The Scheduled Patients list
includes a number of flags that you can use to guide staff assignments and prepare for patient visits,
including lab work, treatment plans, appointment information, insurance eligibility, and more.

Dentrix G4 Productivity Pack 8 Release Guide




4 Productivity Pack 8

Installing Dentrix G4 Productivity Pack 8

The Dentrix G4 Productivity Pack 8 must be installed on each workstation that runs Dentrix. You can easily
install the productivity pack using the Check for Updates feature.

Complete the following steps to check for updates and install Dentrix G4 Productivity Pack 8. If the
update notification appears automatically, skip to Step 3.

1. Before installing Productivity Pack 8, you must have installed Productivity Pack 7. Instructions for
installing Productivity Pack 7 are available in the Dentrix G4 Productivity Pack 7 update guide at the
Dentrix Resource Center (www.dentrix.com/resource-center/).

2. Right.click the Dentrix Quick Launch icon i

the notification area of the Windows task bar Dontrichas found 1 undat
. . entriv has four updates
to open the Quick Launch menu. Next, click Would you like to download these updates now?

Updates and then C“Ck CheCk for Updates~ Tao learn more about the updates that are available click HERE.
The Check for Updates progress message issied Dndotes:
appears, followed by the Downloadable #DENTRISE Ficd it Fack 87 279M8

Updates dialog box.

If the Dentrix Quick Launch icon is not
displayed in the notification area, you can
check for updates by clicking About Dentrix

NOTE: Any Feguired Updates that are downloaded will be installed immediately. |t is

from th e H e | p menu Of a ny m Od u | e an d th en ::;;ﬁ}rg:‘;zr;ﬁ;agdéh;tﬁ:u wait to download updates during a time that you will not be
C| |Ck| ng th e CheCk for U pdates | 1g} k " frams Mmanked reguie a restart of fhe Downloadable Uodate program: Thve willh

haopen aufomaticaly, buf will reguire_pouw fo resefect e oplional updafes fxfed

About DENTRIX ] Optional Updates:

Setial Mumber:

DENTRIX G4 654321 -DECI1WWIE

Copyright 1987-2008
Heniy Schein, Inc.
All Rights Reserved,

z‘ -\\‘~\|E! !sE

Installed Products:

Product Wersion ~

Appointment Book 14.2.42.0 (el iy LTS

Appointrient List 14.2.420 Provide Feedback Mata: Downloading updaias mayiake savaral minulas.

Drentrix Print 14.2.420 B

Document Center 142420 Ves
Diiweb 141.91.0 System Info... |

Family File 14.2.42.0
Ledger 14.2.420 v Close I

Note: If there is a problem with your Internet connection, an error message may appear. Check your
Internet connection and try to check for updates again.

3. Click Yes to download the Required Updates.
The Download Progress message appears while the updates are downloaded and installed.

If you do not have sufficient time to install the update, click the Install Later button and install the
Productivity Pack when you have several minutes to an hour or more to dedicate to installing the
Productivity Pack on the server and on each computer in the office.

4. Follow the on-screen instructions to install the Productivity Pack.

For help with the download and installation of Dentrix G4 Productivity Pack 8, contact Dentrix
Support at (800) 336-8749.
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Installing the Productivity Pack on Other Computers

This Productivity Pack must be installed on each workstation that runs Dentrix G4. Once the productivity
pack is installed on one computer on your network, you can easily install it on any other computer on your
network when you launch any Dentrix module.

When you attempt to open a module on a computer that does not have the required updates, a message
appears notifing you that updates need to be installed.

Important: You must install the required updates in order to use Dentrix on that computer because every
computer on your network must run the same version of Dentrix.

To install the updates, click Install Now from the message that appears. All open Dentrix programs should
close and an install status message box appears. The updates will install and you can then access Dentrix
on that computer.

Dentrix G4 Productivity Pack 8 Release Guide
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Using the New Features and Enhancements

The following information will help you understand how to use the new features and enhancements in this
Productivity Pack.

Appointment Book

ADDING DDX LAB CASE PRESCRIPTIONS AND VIEWING THE DDX LAB CASE LIST
Ordering lab work is much simpler with the addition of a Digital Dental Exchange (DDX) button to the

Appointment Book, Chart, and Treatment Planner toolbars. From the DDX menu, you can log in to the
DDX website to add a prescription or view the lab case list. You can also add prescriptions or view the lab
case list from the Appointment Information dialog box.

To add a DDX Lab Case Prescription or to view the DDX Lab Case List

1. From the Appointment Book toolbar, click the DDX button.

2. From the menu, select New DDX Lab Case Prescription or View DDX Lab Case List.

3. Login to the DDX website.

To add a prescription or to view the lab case list from the Appointment Information dialog box
1. From the Appointment Book, double-click an appointment.

2. From the Appointment Information dialog box, click Patient Lab Cases.

3. From the Patient Lab Cases dialog box, click New DDX Rx or DDX Case List.

4. Login to the DDX website.

RESTORING ALL APPOINTMENTS FROM THE PINBOARD

At times you may have to reschedule a large number of appointments without losing track of any.

Improvements to the Pinboard let you move all appointments for a day, an operatory, or a provider to

the Pinboard for rescheduling. If you have a mixed group of scheduled and unscheduled appointments

on the Pinboard, you can restore all scheduled appointments and move the unscheduled ones to the

Unscheduled Appointment list or leave them on the Pinboard.

To restore all appointments from the Pinboard

1. Right-click an appointment on the Pinboard, and from the menu, select Restore All Pinboard
Appointments.

Note: If one or more of the Pinboard appointments cannot be restored, you can keep the appoint-
ments on the Pinboard or move them to the Unscheduled list.

2. Select the appropriate option and click OK.

PLACING EVENTS ON AND DELETING EVENTS FROM THE PINBOARD

You can click the Pinboard or Delete buttons on the Edit Event dialog box to place an event on or delete
an event from the Pinboard.

To place an event on the Pinboard

1. From the Appointment Book, right-click the event that you want to place on the Pinboard and select
Edit Event from the shortcut menu.

2. From the Edit Event dialog box, click Pinboard.
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To delete an event from the Pinboard

1. From the Pinboard, right-click the event that you want to delete and select Edit Event from the
shortcut menu.

2. From the Edit Event dialog box, click Delete.

GENERATING PATIENT VISIT FORMS

The Patient Visit Form is a customizable route slip that you can view or print for a selected appointment, a
certain patient, or multiple patients. You can filter the forms that are generated by primary provider,
appointment provider, operatory, and appointment date. The form can include patient, family, account,
continuing care, and insurance information; patient and family alerts; patient and account notes;
treatment-planned procedures; and future appointments.

To generate a Patient Visit Form

1. From the Appointment Book, select the
appointment you want to generate a visit form
for.

0P03

Ir. Beamagard, Richard ||
Periodici, Prophwdd

H:[248]374-0038

HDMD

083

2. From the toolbar, click Patient Visit Form.

3. Setupthe
. Patient Visit Form
report OpthﬂS,
indicating the Select Patient Select Report Options
inform ation yOU + Patient for Selected Appointment ¥ Include Detailed Patient Information ¥ Include Insurance Infarmation
. ™ 2l Patients ¥ Include Patient’s Continuing Care v Frimary Dental IV Primary Medical
want to include, - = . & Detailed & Detaled
. | v Include Patient &lerts
and then click [  Brief  Bret

W Include Family Alerts

| Select Primary Provider
Preview. b ¥ Include Patient Motes ¥ Secondary Dental W Secondarny Medical

From: To (v i Ic) i
(i i @iy Detailed Detailed
- - ) " Brief " Brief
Select Appaintment Provider v Include Referal Information
¥ Include Family Infarmation

. - W Include Account Infarmatian
From: |alls . | Too |<aLLs o Select First CC To Include For Family

W Include Guarantar Account Mate
PROPHY |
Select Operatory N |
[ First Line Only Select Second CC To Include For Farnily
From [call> 5. | To feally > ¥ Include Treatment Plan Procedures |BITEWINGS |
Bppointment Diate (+ Scheduled for this Appointment Select Third CC To Include For Farnily
™ llfor Patient |FERID =l

Frarn: | J To | J

IV Include Patient's Future Appointrments

W Do Mot Close When P resie h Preview | Send To Batch | Frint | Cancel |

Mon 05/03/2010 at 9:00am OP02 HKMR 60 min PATI ENT VISIT Fo RM For Ludoni, Johnna Page: 1

Patient Ludoni, Johnna Chart# LUO009 SS# ###-##-4455 Birth: 11/11/1957 Age: 53 Married
Medical Alerts:
Appointment Mon 05/03/2010 at 9:00am OP02 HKMR 60 min Status: <none> Reason:proa...vmt Amount: 113.00
Note: proa...vmt
Patient Detail Home (734)555-9347 Mobile Work (734)555-0078 Other Fax
123456 Joy Rd Last Referred To: Endodontics PC, 08/24/2010 Prov1: DCJR Prov2: HMAA
Livonia, MI 48150 Employer: Ludoni Bakery Consent Date: ~ 10/16/07
Prophy Due: 05/03/10 Prior Tx: 11/02/09 First Visit Date:  10/16/07
E-mail: Missed Appt #: 1 Last Missed: 08/12/08 Last Visit Date:  11/02/09

Patient Alerts AP
Patient Notes Johnna brings cookies on the first Monday of every month from her bakery.
Guarantor Account Note Payment required before starting treatment

Primary Dental Insurance Delta Dental New Jersey Subscriber: Ludoni, David
Group #: 58550101 Phone: (800)555-9310 Subscriber ID: 000000000 Birth: 11/11/1964
Benefits P Max: 1,000 Used 79.00 Pend 142.00 Rem 0.00 Employer: Pitney Bowes
Benefits F Max: 0 Used 524.00 Pend 142.00 Rem 0.00 Ren: Jan Ded Owed S/P/O: Pat 0/0/0  Fam -100/0/0
Code Category % |D|| Code Category % |D|| Code Category % |D|| Code Category % |D|| Code Category % |D
0100 | Diag/Preventive |100|P|22000 | Basic Restor 50 |S|D2700 Crowns 50 [S|[22900 | Other Restor. | 50 |S|[23000 | Endodontics 50 |S
4000 | Periodontics 50 |S||25000 | Prostho, remov | 50 |S|[25900 | Maxillo. Prosth | 50 | S| 26000 Implants 0 |S|[26200 | Prostho, fixed | 50 |S
D7000 | Oral Surgery 0 |S|[28000 | Orthodontics 50 |O]P9000 | Adjgen serv 50 |S
Note: - Tue - Nov 3, 2009 -Ortho Max $2000
Treatment Plan (all for patient) (estimates do not include dental plan maximums and deductibles)
Date [ Visit [ Th | Suf | Code | Procedure Fee Pat Est Pri Ins Sec Ins|
8/24/10 | o | 8 | MD |p2160 |Amalgam-3 surf. prim/perm 94.00) 94.00 0.00 0.00
TOTALS: 94.00] 94.00 0.00 0.00
Patient Appoi [ Date | Time | Prov |Reason
| 08/26/2010 | 10:00am | DCJR [GnFIInRtP

7
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Ledger

SETTING UP INSURANCE WRITE-OFF AND REFUND ADJUSTMENT TYPES

A new Insurance Payment Setup option allows you to set up default insurance write-off and refund
adjustment types, enable automatic adjustments for insurance payments, and post refund adjustments
automatically in place of entering negative insurance payment amounts. Additionally, you can set up
secondary insurance claims to be created automatically whenever primary claim payments are made.

To set up a default insurance write-off adjustment type
1.

In the Ledger, from the File menu, click Insurance
Payment Setup.

In the Insurance Payment Setup dialog box, under
Insurance Adjustment Setup, click the Default
Insurance Write-Off Adjustment Type (-) search
button.

From the Select Adjustment Type dialog box,
select the write-off adjustment type that you want
to use, and click OK.

To set up a default insurance refund adjustment type

1.

In Ledger, from the File menu, click Insurance
Payment Setup.

Under Insurance Adjustment Setup, click the
Default Insurance Refund Adjustment Type (+)
search button.

From the Select Adjustment Type dialog box,
select the refund adjustment type that you want to
use, and click OK.

Insurance Payment Sefup

Inzurance Adustment Setup
Default Ingurance ‘wWiite-OFff Adjustment Topel-]:
[afrite-Dff

Default Insurance Refund Adjustment Typel+):
|+Insurance Ower-pmt Refund E3

[V Ernable Automatic Sdiustments for Insurance Payments
[ Auto-post Refund adiustments to replace negative papments

Additional Options
Apply Mon-temized Payments in Batch Entry to:

|Elaim Pay-To-Prowider j
Apply Adustments for Mon-ltemized Payments to;
|F'atient's Pron j

[V Auto-Create Secondary Claim with Primary Payment
[ Auto-Feceive Secondary Claim if o Pending Ins Estimate
Iv Copy Electronic EQBs to Document Center

ak. | Cahcel

3

SETTING UP AUTOMATIC ADJUSTMENTS FOR INSURANCE PAYMENTS

This option automatically calculates adjustments and splits them among providers, if necessary, according

to the payment that is entered for an insurance claim.

To enable automatic adjustments for insurance payments

In the Insurance Payment Setup dialog box, under Insurance Adjustment Setup, click Enable

Automatic Adjustments for Insurance Payments.

POSTING REFUND ADJUSTMENTS AUTOMATICALLY TO REPLACE NEGATIVE PAYMENTS

Selecting this option allows you to post refund adjustments automatically in place of entering negative
insurance payment amounts.

To post refund adjustments automatically to replace negative payments

CREATING SECONDARY CLAIMS AUTOMATICALLY

In the Insurance Payment Setup dialog box, under Insurance Adjustment Setup, click Enable
Automatic Adjustments for Insurance Payments and then click Auto-post Refund adjustments to

replace negative payments.

This option creates a secondary dental claim automatically whenever a primary dental insurance claim
payment is posted and if the following is true:

Dentrix G4 Productivity Pack 8 Release Guide

A patient has secondary insurance set up in Family File.

A secondary dental claim has not been created already.
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To create a secondary dental claim automatically when you submit a primary payment

1. Inthe Insurance Payment Setup dialog box, under Additional Options, click Auto-Create Secondary
Claim with Primary Payment.

2. To mark the secondary dental claim as “received” if no pending insurance estimate exists, click Auto-
Receive Secondary Claim if No Pending Ins Estimate.

ADJUSTING INSURANCE PAYMENTS AUTOMATICALLY

Dentrix will automatically adjust insurance payments if you select Enable Automatic Adjustments for
Insurance Payments in the Insurance Payment Setup dialog box.

To make adjustments to insurance payments automatically

1. From the Insurance Claim dialog box, in the Enter Payment shortcut menu, click Itemize by Procedure
or Total Payment Only.

The Total Insurance Payment dialog box appears.

° =
If the total . Total Insurance Payment FS_(|
amount paid =
'FOI’ the claim Enter Insurance Payment Claim Totalz
is less than [rate |08/30/2010 Fre-tuth Number
the total Check # Coverage Amaount 41.00
billed, Dentrix | | Bank/Branch tt etal Amount Biled TG0
calculates a & Check Papment
Write-Off (-) £ Electronic Payment Itemized Total 0.00

. Provider Amnounts
adJ ustment Calculate according to: Tatal &maount Paid 0.00
and displays (% Family Balance ™ Patient Balance
. Enter Adjustment
It under Enter Pravw Itemized Balance - Amt Paid = Hew Bal - el -
Adjustment 0051 000 242200 000 242200 Wiks DI () =] @ § © % Type | Frofession Coutesy =
in the Total Tokal Amount
Amount text ¥ Split Adjustment by Provider Prayv Amts.,..
box.

Payment T otal .00

°
If the total ) Add | Edt | Fre-apply Amt Paid using FIFD
amount paid
for the claim is Deductible Applied For Claim

Standard Preventive  Other
more than the [T [0.00 [ Ok./Past
total amount Cancel
billed, Dentrix
calculates a

Refund (+) adjustment and displays it under Enter Adjustment in the Total Amount text box.

e |f the total amount of the adjustment applies to more than one provider, Dentrix selects Split
Adjustment by Provider, calculates the adjustment amounts for each provider, and displays the
adjustment amounts and providers under Provider Amounts when the insurance payment is
posted.

e |f a payment amount for the claim is negative and you selected Auto-post Refund Adjustments to
replace negative payments, Dentrix calculates a Refund (+) adjustment and displays it according
to the negative payment amount that you entered.

2. To view or modify the adjustments for each provider, click Split Adjustment by Provider and then click
Prov Amts.

3. Inthe Provider Amounts for Write-Off (-) dialog box, select a provider from the list and click Edit.

In the Provider Adjustment Amount for Write-Off (-) dialog box, enter the amount of the adjustment,
and then click OK.

Dentrix G4 Productivity Pack 8 Release Guide
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VIEWING AUTOMATIC INSURANCE PAYMENT ADJUSTMENTS

The Show Transaction Links option under View in Ledger now includes any posted adjustments that are
associated with an insurance claim. For example, if you post a payment to and adjust an insurance claim,
when you click Show Transaction Links for that claim, the claim—and the procedures, payments, and
adjustments associated with it—are selected in Ledger.

Claim adjustments are also reflected in the Insurance Claim dialog box.

I Dentrix Ledger - Crosby, Brent L [CROD1]

File Options “iew Transaction Insurance Print Month End  Help

T ooth| Code Balance | |
07/02/2008 | Brent L Croghy 01110 Prophwlasiz-adult . E1.00 A
07/02/2008 | Brent L Croghy 00274 | Bitewings-four filmg . 10200 =
Erert L Crogh D0120] Periodic oral evalustion 13200
ent L Crozhy D7140 Extract.erupted th 1]
07/02/2008 | Brent L Croghy DED0| Surg place implant; endosteal 226000
07/02/2008 | Brent L Croghy D2750| Crown-porc fuge high noble mtl 749.00 3009.00
01/18/2010 | Brent L Croghy Inz | PrDental Claim - Batched  31.00 3009.00
M A82010 [Brent L Crozhy Inz | PrDental Claim - Created  E1.00 3009.00
0240242010 | Brent L Crozhy Inz | PrDental Claim - Created  41.00 3009.00
08/05/2010 | Brent L Crozhy Inz | PrDental Claim - Created 745.00 3009.00
Erent L Crosh Inz | PrDental Claim - Created 154000 3009,
tLCl Adp white-Off - 289
Pay 1ent
Ins im - Rec'd 587

Note: Insurance claim adjustments that have been moved to history cannot be modified or deleted. If
you double-click an adjustment in the Insurance Claim dialog box, and it has not been sent to history, the
Change or Delete Adjustment dialog box appears.

Prescriptions

BACKDATING AND REFILLING PRESCRIPTIONS

You can now correct prescription dates, if necessary, or enter a date for a new prescription that cannot be
filled immediately. This can be very convenient for patients who cannot return for an office visit or when a
doctor is not available to patients. Also, you can click the new Refill button to re-fill a prescription.

To backdate a prescription

1. After selecting a patient and from any Dentrix module’s toolbar (except Office Manager), click
Prescriptions.

Patient Prescriptions

2. From the Patient Prescriptions dialog box, click
NeW- Preszcriptions for: Brent L. Crosby il
3. From the New Patient Prescription dialog box, [ Date Desciiption Diug Mame Fresciber |
11 0 i

change the date in the Date text box to one = . LI
prior to the current date.

To refill a prescription

1. After selecting a patient and from any Dentrix
module’s toolbar (except Office Manager), click
Prescriptions.

Mot a standard \ption
2. From the If’at.|ent Prescrlpt!ons dialog box, select = Vew | Deete | Repors | Cose |
the prescription from the list that you want to

refill and click Refill.

3. From the View Patient Prescription dialog box, enter the number of times you will allow the patient to
refill the prescription.
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PRINTING ON TAMPER-PROOF PAPER
Three new prescription forms have been added to the Printer Setup Form list to support printing on
tamper-proof paper.
To select a tamper-proof form
1. From the Office Manager, click Maintenance > Practice Setup > Prescriptions Setup.
2. Click Print Setup.
3. Under Form, select one of the following tamper-proof forms.
e WA State Full-sheet
e WA State Half-sheet
* WA State Standard

Questionnaires

REQUIRING RESPONSES TO QUESTIONNAIRES

You can now require answers to questionnaire questions, ensuring patients provide information critical to
your practice, such as secondary insurance policies.

To require a response to a question

1. From the Edit menu of the Questionnaires module, click Questionnaire Setup.

2. From the Questionnaire Setup dialog box, click New Form and then select Copy Selected Form to
create a new form based on an existing one.

3. From the Questionnaire Form Setup dialog box, select the questions you want to require an answer
for under the Req column.

Questionnaire Form Setup

Form Categany: Forrn M ame: Respondents:

g |Pal|enl Imformation Form(3) ‘ |Pat|ent A ‘ Include Practice Information
[] Responses ta form expie evaryl:l monthiz) Electronic Signature(s) for Questionnaire: Patient Frovider 53 MienPrint Form...
Form Questions:

Question Responze Type Req |

:‘ Patient Information n E dit Questi

_| ugstion...
Pleage take a moment ko enter or update pour information to help us enzure the qua... | Mone-Body Text a
Pl-Patient Demographics, Brief PI-Patient Demographics, Brief ] -
- - : Ingert Patient Info. .
Prefemed appointment times: Checkbox List O
. - -
‘whom may we thank for refeming you to our practice? Checkbox List | \nsert Blank Line
Mame of person, office, or ather source referming you to our practice: MNone-Body Text al
Pl-Referal Name FI-Referral Mame O
Insert Separatar
------------------------------------------------------ Nore-Page Break ]
Spouze or Fespongible Party Information Mone-Header Text a
- Inzert Page Break
PI-5pouse/Resp Parly, Brief Pl-Spouse/FResp Party, Brief |
Employrment |nformation Mone-Header Text al
elete
PI-Employment Info FI-Employment Info

Note: If you require an answer to a question and patients click the Submit button before providing all
required responses, a message appears informing them that they must respond to all required ques-
tions.

Dentrix G4 Productivity Pack 8 Release Guide
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UPDATING PATIENT INFORMATION

When you select a referral, employer, or insurance plan from the Update Patient Information dialog
box in the Questionnaires module, the corresponding text that was entered in the Questionnaire form
automatically populates the name fields of the Select Patient, Select Employer, and Select Dental
Insurance windows respectively.

INSERTING NOTES INTO PATIENT-RELATED NOTE FIELDS

A new option in the Question Setup dialog box lets you insert notes from a Questionnaire form into any
patient-related note field to update patient information or to create new patient alerts.

To insert a note from a Questionnaire form into a note field e choms et tm o
gsponse [ype (choose one of the followingl
1. From Questionnaires, click Edit > Questionnaire Setup. T el e s o
b Header Text aige-size test, no response indicates
Text nse indicated
2. Select a Questionnaire Form and click New Form or Edit Form. T T
Date Response. Provides for a dateto be selected o entered
. . . . . “tes or No Respanse Provides for"es” or "No" to be selected
3. From the Questionnaire Form Setup dialog box, click New Question | jusersme fosswenmone
Ed. Q . Orne Choice From List Alistis setup for one item to be selected L
or eait Question. Evtosan P ngen ot o sechtos %
4. From the Question Setup dialog box, select Note Response from s T [t
. . . |
the Response Type list and then click Use Note to Update Patient
Information.
SETTING EXPIRATION DATES Defauit Riesponse for data enty (optionall @
You can now set expiration dates on questionnaires to help you and your
staff keep your patient records updated. Keeping these records updated
helps ensure that billing and mailing information is correct and that
. 1 Mumber oflines 1o provide for tex!
patlents dOﬂ t fa” thI’OUgh the CraCkS' [] Use Note to Updale Patent Information
[ Feenpie response for tis field

To set an expiration date
1. From the Edit menu of the Questionnaires module, click Questionnaire Setup.
2. Select a questionnaire form from the list and click the Set Expiration button.

3. From the Set Expiration For Responses dialog box, select the number of months that you want to
pass before requiring patients to update their responses to the selected form and click OK.

ADDING, CHANGING, OR DELETING MEDICAL ALERTS

Whenever you add, change, or delete a medical alert in the Practice Definitions dialog box, the

Questionnaire forms that use medical alerts are updated atuomatically to include these changes.

To add, change, or delete a medical alert

1. From the Practice Definitions dialog box, select Medical Alerts from the Definition Type list.
a. Ifyou are changing or deleting a medical alert, select a definition text from the list.

2. As appropriate, click Add, Change, or Delete.

A message appears stating that any changes to Medical Alerts will update any Questionnaire form
that uses Medical Alerts.

3. Click OK to continue.

Dentrix updates the Questionnaire forms appropriately.
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DAILY HUDDLE REPORT
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You can use the production, collections, case acceptance, new patients, and scheduling details of the Daily
Huddle Report during your office’s morning staff meetings to provide some daily statistics to help you focus on
the patients coming in for treatment on the current day and/or the following day.

To run the Daily Huddle Report

1. In the Office Manager, from the Analysis menu, click Practice Advisor to
open the Practice Advisor dialog box.

2. Click Daily Huddle Report.

In the Daily Huddle Report dialog box, select
a set of previously saved report options, or

: Daily Huddle Report
change the default report options. aily Huddle Repor

Options:

4. Click Preview to preview the report. [Dataut

A3

Enter Date for "Today"

08417/2010 v

PBroduction & Collactions By
(%) Entry Date

) Procedure Date

Selected D entizts Selected Hygienists
All

HYG1

DD5S1
DDs2
DDS3
ENDO
ORTH
PEDOD
PERI

SURG

Select Report Options

Mumber OF Copies:

Include Cover Page of Options Selected
Send Route Slip to Batch Processor for:
Today's Appointments

Tomarraw's Appaintments

% Practice Advisor

[ FPractice Advizor Feport _|

2 ) Daily Huddle Repart

Select Report Sections & Related Options
D aily Huddle Summary

Appointment Mote
Production

Include Dentist Detail

Include Hygienist Detail
Collections
Casze Acoeptance
Mew Patients
Include Dentist Detail
Scheduling
Include Dentist Detail
Include Hygienist D etail
Scheduled Patients Summary
Include All Scheduled Patients
Scheduled Patients List
Scheduled Patients Phone List

[ Scheduled Patients Setup...

Unfilled Hours Calculations
(®) Exclude Double-Scheduled Time
) Include Double-Scheduled Time

[ M anage Options.. ] [ Save Options.

] ( 4 ‘Preiiew _H Cancel

Daily Huddle Report

Daily Huddle Summary
Today is: 11/12/2009

Page: 2 of 54

Appointment Day Note:

the office the whole week.

This is a note to remind everyone to work on filling the schedule for next week. And it isTina's birthday and Joy will be out of

Completed Scheduled Completed Scheduled

PRODUCTION Prior Day Today MTD Rem Month Total MTD Goal
Dentist Completed/Scheduled 13,284.00 8,636.00 135,197.00 96,798.00 231,995.00 326,000.00
Hygienist Completed/Scheduled 5,104.00 3,475.00 31,530.00 39,891.00 71,421.00 100,080.00 ‘
Total Production Completed/Scheduled 18,388.00 12,111.00 166,727.00 136,689.00 303,416.00 426,080.00

COLLECTIONS Prior Day % MTD %
Collections (% Production) 16,394.96 89% 131,205.29 79%

CASE ACCEPTANCE Prior Day MTD

Amount of Treatment Diagnosed 30,038.00 299,936.00
Amount of Treatment Accepted 9,210.00 74,192.00

Dentrix G4 Productivity Pack 8 Release Guide
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Miscellaneous Features

INSERTING MERGE FIELD CODES

An add-in for Microsoft Word 2007 and 2010 lets you easily insert letter merge field codes from Dentrix.
Installation of the add-in is simple. Dentrix detects whether Microsoft 2007 or 2010 is installed, and if it is,
automatically installs the add-in. You can also install or re-install the add-in using the Dentrix Select Install
feature.

The Dentrix Installer adds a Dentrix button to the Mailings tab in the Microsoft Word ribbon. You can
show or hide the button in a new task pane. The Dentrix Letter Merge Fields task pane consists of a
toolbar with a list of available merge fields.

To insert a merge field code

1. Place your cursor in the document where you want to insert the merge field code.

2. Select a merge field code from the list and from the toolbar, click the Insert Field button.

The merge field code is inserted into the document.

(@ [= - BN N b I % Documentl - Microsoft Word e
oy

Home  Inset  Pagelayout  References | Malings | Review  View  Acobat e
-S| P

-

< Mergeta | [Letter Mergel

Adabe POF ||| Fieids
Acrobat oenTRI

1X Letter Merge Flelds +

o s ) J

= Patient -~

Fast Name
M
Last Hame
Preterred Mame
Sakutation
Saktation [
Tite

L A —

{ MERGEFIELD FName },

USING THE DENTRIX LAUNCHER

The new Dentrix Launcher provides you with an easy-to-use graphical interface to get new and temporary
staff up-to-speed quickly. The Dentrix Launcher starts automatically for new users whenever they log in.
For existing users, the automatic start option is turned off. The Dentrix Launcher also allows you to create
and save custom views.

To open a module from the Dentrix Launcher

e  From the Dentrix Launcher, click the
object or icon that corresponds to
the module you want to open.

For example, to open the
Appointment Book, click the image
of the monitor beneath the white

board.
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Productivity Pack 8 Software Changes and Fixes

Dentrix G4 Productivity Pack 8 contains the following software changes and fixes:

Appomtment Book

Running an Appointment Book View Report starting at 12:00 p.m. (noon) caused an invalid time error
icon to appear. This has been fixed.

e The printed Appointment Book View Report displayed the providers in a different order than they
appeared in the Appointment Book’s provider list. The printed report now shows them in the same
order as the Appointment Book.

* Moving an appointment to the Pinboard from the Appointment Information dialog box (using
the Pinboard button) caused the appointment status to be cleared when the appointment was
rescheduled. This has been fixed.

e Clearing the View Appt Note option in Appointment Book’s Select View dialog box (click View > Edit)
caused the Hover Window to no longer display the note. The Hover Window information is no longer
filtered based on the current View restrictions; the information that appears is based only on the
settings in the Hover Detail Setup dialog box.

e |f a patient was initially scheduled in the Appointment Book at a time when the provider was
unavailable, and the patient was then moved to a new appointment time, the error message
"Provider unavailable at requested time! Schedule appointment?” appeared repeatedly. This has
been fixed.

e For some customers, switching between days in the Appointment Book caused a brief delay. This has
been addressed, and the response time is significantly faster.

* The Appointment Book toolbar now incudes a DDX button. Clicking the button opens a menu from
which you can select New DDX Lab Case Prescription and View DDX Lab Case List. (The DDX button
was also added to the Chart and Treatment Planner toolbars.)

e The Attach Case button in the Appointment Information dialog box was replaced by the Patient Lab
Cases button. The Patient Lab Cases dialog box now includes the New DDX Rx and DDX Case List
buttons.

e Opening the ASAP List and selecting an appointment while the Unscheduled List was open caused
an error message to appear. This has been fixed.

e When using the Appointment Book's Day View and configuring the view (using View > New) to
exclude the amount, alerts, and notes, the Hover window did not display all information it should
have. For example, the Work Phone, Mobile Phone, Primary Insurance information, Account Balance,
and Appt Note did not appear. This information now appears in the Hover window.

e Closing an individual operatory for a day caused the entire Appointment Book day to appear closed
for scheduling. This has been fixed.

e |f you moved an appointment from the Appointment Book’s Unscheduled List to the Pinboard,
and then attempted to reschedule the appointment by dragging it to an area of the Appointment
Book (particularly where the Unscheduled List window was previously opened on your screen), the
appointment could not be rescheduled. This has been fixed.

Famlly File

Clicking Print Label from the Patient Referrals dialog box opened the Quick Labels dialog box with
the incorrect patient selected. This has been fixed. The label now prints automatically without the
dialog box appearing (as was done prior to Productivity Pack 7).

e Kiosk forms allowed you to enter more than one character for a patient’s middle initial and then
import the data into the Dentrix database, causing data errors. Now, only one character is allowed in
the Middle Initial text box during an import in Family File.

Dentrix G4 Productivity Pack 8 Release Guide
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The warning message that appears when you change the insurance information in Family File and
select the Change Plan for All option has been rewritten to emphasize that even records in history
will be affected. The new message now includes, "“Clicking Yes will change all claims attached to this
insurance plan, including those in History, in addition to changing the insurance information for all
subscribers.” Also, the error message that appears after clicking OK was difficult to read because of
several line breaks that were inserted in the message. These line breaks have been removed.

Offlce Manager

Printing an Appointment History List in Office Manager used to show the date and time of the
Scheduled appointment in the History Date/User column. It now shows the date and time the
appointment was last modified.

In the Provider A/R Totals Report, the Adjustments column always reported a 0 when the report was
run for a previous year. This has been fixed, and the report now shows the correct adjustment amount.

In the “Aged Accounts Receivable” section of the Practice Advisor Report, the “A/R with Pending
Insurance Claims” balance showed a balance even when there were no outstanding claims. This has
been fixed.

Three new prescription forms have been added to the Printer Setup Form list to support printing on
tamper-proof paper. To access the new tamper-proof forms, in Office Manager click Maintenance >
Practice Setup > Prescriptions Setup. Click Print Setup. Under Form, you can select from the three
new tamper-proof forms: WA State Full-sheet, WA State Half-sheet, and WA State Standard.

Three new prescription forms have been added to the Printer Setup Form list to support printing on
tamper-proof paper. To access the new tamper-proof forms, in Office Manager click Maintenance >
Practice Setup > Prescriptions Setup. Click Print Setup. Under Form, you can select from the three
new tamper-proof forms: WA State Full-sheet, WA State Half-sheet, and WA State Standard.

Patient Chart

Attempting to back date a clinical note to a date in History made it inactive but did not update the
note's date. This has been corrected, and the note's date is now updated.

Saving custom settings in the Print Patient Chart dialog box did not always permanently save the
settings. For example, if you canceled the dialog box then closed and re-opened Patient Chart, the
settings in the Print Patient Chart dialog box were not saved. This has been fixed.

Prescriptions

Prescriptions can now be backdated, and a Date text box was added for new prescriptions.

Prescriptions can be re-activated for refills. The Refill button opens the View Patient Prescription
dialog box.

Questionnaires

When a new patient questionnaire form was created from the website and then moved to an existing
patient, the system did not change the "NP” (new patient). As a result, when the questionnaire form
required further updates (such as adding an electronic signature), the form was still flagged as a “new
patient” form. This has been fixed.

When setting up a questionnaire, users now have the option to require a question to be answered
before the questionnaire can be submitted.

The Submit button now only has focus on the last page of a questionnaire.

When a medical alert exceeded 20 characters, the Update Patient Information dialog box did not
display every medical alert. This has been fixed.
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e Users can now insert a note into any patient related Note fields or to create a new patient alert.

e When users add, change, or delete medical alerts in Definitions, users are asked to automatically
update any Questionnaire forms that use medical alerts.

Treatment Planner

e After making changes to a consent form attached to a treatment plan, the updated version of the
consent form could not be viewed until after Treatment Planner was manually refreshed or closed and
then restarted. This has been fixed, and changes to the consent form can now be viewed when the
consent form is subsequently opened for editing.

Practice Advisor

e Inthe “Aged Accounts Receivable” section of the Practice Advisor Report, the “A/R with Pending
Insurance Claims” balance showed a balance even when there were no outstanding claims. This has
been fixed.

e |f a provider was double-scheduled in the Appointment Book, the Unfilled Hours statistic in the
Practice Advisor Report always included the double-scheduled provider time. For example, if a
provider is available for eight hours of appointments in one day and has eight hours of appointments
scheduled, but two of those hours are double-scheduled, the provider would still have two hours
available for additional appointments. However, the Practice Advisor Report was reporting Unfilled
Hours as O since eight hours were available and eight hours were scheduled. To address this issue, the
Practice Advisor Report dialog box now includes new options under Unfilled Hours Calculations.
These options let you specify whether you want to Exclude Double-Scheduled Time or Include
Double-Scheduled Time in the Unfilled Hours statistic.

Practice Advisor Report

Cptione: Satect Dertists Selert Hygienists Select Report Seclions & Related Optiors
Defeut b [ A [ A Froductan
Genarata Rapod As O ggg;{u HYG1 Irciude Dertist Detsil
[omzzzon ] D053 Inciude Hygenist Detal
gﬁ% [#] Inciude Graphs for Praduction
Froduction & Callections By EEE‘? Collections
(&) Entry Dzte SUAG [#] Inciude Collections Graphs
) Procedure Date Wew Patiert, Analysis
Select Biling Types [#] inciude Dertist Detail
YTD Calevlatinne By o Inciude Graphs for Mew Patient Analysie
() Fiscal Year ; gmﬁad Eing -fnafma changas [#] Confinuing Care
dard Biling -
© Calendsr Year T e oing e fance charges Selact OC Types
-15: Irsuranca Family - Dual Insuranca Al
L § Insurance Famify - finance chamges
i C fana:
Linfled Hours Calculations E: Payment Flan -finance charges PROPHY perinedic chaaning and exam
(% Exclude Double-Scheduled Time T. Payment Flan - ra friance charges BITEWINGS arnual bewings
B: Ead Dbt - at riske ORTHD oitho post fretmant stabiiz.
¥ Include Double-Scheduled Time % Bad Debt -t colections PANOREX panoramic fim
100 Mo Seatement and Mo Finance Changes FERID percdontal maintenance
SCHEENING orall CanCar BCIEEng
FME Full Mewth Xrays
Salect Repont Oplions
Mumber of Copies: 1 = |

[#] chide Recommendation Footrotes
nchude Caver Pags of Optiors Sslected

[[] Sendita eMaj Addrmsees:

This is a detafied report that takes considerable time fo generste,

[#] Include: Graphs for Cantinuing Care
Schgdule Management

Indiude Dertist Detail

Include: Hygienist Detal

Irnciude Graphs for Scheduls Managamant

| Preew |[ Cancel |

Dentrix G4 Productivity Pack 8 Release Guide



18 Productivity Pack 8

How to Learn More about this Release

For complete information on how to use the new features in this Productivity Pack, refer to the Dentrix
G4 Help. For information about new features and enhancements in previous Dentrix releases, see the
“What's New in Dentrix?” section of the Dentrix G4 Help.

You can view on-demand tutorials, sign up for live webinars, and view webinars in the Resource Center at
dentrix.com if you have an active customer service plan. From the Resource Center, you can also access
PDF copies of the Reports Reference, User's Guide, System Requirements, and FAQs.
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